PowerLite 1810p/1815p

Projector Parts
Remote
receiver

Control panel

Wireless
module
(1815p only)

Lamp cover
Zoom ring

Focus ring

Speaker

Projection
methods

Front, rear, upside-down (ceiling mount)

Internal
sound system

5 W monaural

Optical aspect
ratio

4:3 (horizontal:vertical)
(supports 16:9)

Zoom ratio

1:1.6

Noise level

32 dB (low brightness)
37 dB (high brightness)

Keystone
correction

±30° vertical (automatic)
±45° vertical (manual)
±45° vertical (Quick Setup)
±25° horizontal (manual/Quick Setup)

Mouse
compatibility

Supports USB (type B)

A/V mute slide
Air exhaust vent
Foot adjust lever

Audio input ports

Monitor
out port

Projection Lamp

USB port type B
Network port (1815p only)

Computer
input ports

Audio
out port

USB port type A
(1815p only)

Type

UHE (Ultra High Efficiency)

Power
consumption

210 W

Lamp life

Approx. 3,000 hours (low brightness)
Approx, 2,500 hours (high brightness)

Part number

V13H010L40

Remote Control
Audio input ports

S-Video
port

Remote receiver
Video input port

Power inlet

Range

20 feet (6 meters)

Batteries (2)

Alkaline AAA

Dimensions

Rear adjustable foot

Specifications

Height

3.4 inches (86 mm), feet retracted

Width

13.6 inches (345 mm)

Depth

10.1 inches (257 mm)

Weight

PowerLite 1810p: 6.5 lb (2.9 kg)
PowerLite 1815p: 6.9 lb (3.1 kg)

General
Type of display

Poly-silicon TFT active matrix

Resolution
(native format)

1024 × 768 pixels (XGA)

Color
reproduction

Electrical
Rated frequency

50/60 Hz AC

Full color, 16.8 million colors

Power supply

100 to 120 VAC, 3.4A
200 to 240 VAC, 1.5 A

Brightness

3,500 lumens (high brightness)
2,700 lumens (low brightness)

Contrast ratio

500:1

Image size
(diagonal)

30 to 300 inches (0.8 to 7.6 meters)

Power consumption
Operating:
100 to 120 VAC, 306 W
220 to 240 VAC, 286 W
Standby
(network off):
100 to 120 VAC, 2.6 W
220 to 240 VAC, 4.6 W

Projection
distance

2.7 to 48.2 feet (0.8 to 14.7 meters)
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Environmental
Temperature

Operating: 41 to 95 °F (5 to 35 °C)
Storage: 14 to 140 °F (–10 to 60 °C)

Humidity
(non-condensing)

Operating: 20 to 80% RH
Storage: 10 to 90% RH

Operating altitude Up to 7,500 feet (2,286 meters)

Safety and Approvals
United States

FCC 47CFR Part15B Class B (DoC)
UL60950 Third Edition

Canada

ICES-003 Class B
CSA C22.2 No. 60950

CE Marking

Directive 73/23/EEC
Directive 89/336/EEC
IEC 60950 Third Edition
EN 55022, EN 55024

Compatible Video Formats
The projector supports the high definition video and computer
display formats listed below, as well as traditional NTSC, PAL,
and SECAM video standards. To project images output from a
computer, the computer’s video card must be set at a refresh
rate (vertical frequency) that is compatible with the projector.
Some images are automatically resized using Epson’s SizeWize
technology to display in the projector’s native format (XGA).
The frequencies of some computers may not allow images to
display correctly; see your computer’s documentation for
details.

TM

Mode

Refresh Rate
(Hz)

Resolution

VGA EGA

70

640 × 350

VGA—60
VESA—72
VESA—75
VESA—85
VGA—120

60
72
75
85
120

640 × 480
640 × 480
640 × 480
640 × 480
640 × 480

SVGA—56
SVGA—60
SVGA—72
SVGA—75
SVGA—85
SVGA—120

56
60
72
75
85
120

800 × 600
800 × 600
800 × 600
800 × 600
800 × 600
800 × 600

XGA—60
XGA—70
XGA—75
XGA—85
XGA—120

60
70
75
85
120

1024 × 768
1024 × 768
1024 × 768
1024 × 768
1024 × 768
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Mode

Refresh Rate
(Hz)

Resolution

SXGA1—70
SXGA1—75
SXGA1—85
SXGA1—1205

70
75
85
120

1152 × 864
1152 × 864
1152 × 864
1152 × 864

SXGA2—60
SXGA2—75
SXGA2—85

60
75
85

1280 × 960
1280 × 960
1280 × 960

SXGA+60
SXGA+75
SXGA+85

60
75
85

1400 × 1050
1400 × 1050
1400 × 1050

SXGA3—60
SXGA3—75
SXGA3—85

60
75
85

1280 × 1024
1280 × 1024
1280 × 1024

UXGA—60

60

1600 × 1200

iMAC VGA
iMAC SVGA
iMAC XGA
MAC13
MAC16
MAC19
MAC19—60
MAC21

117
95
75
67
75
75
59
75

640 × 480
800 × 600
1024 × 768
640 × 480
832 × 624
1024 × 768
1024 × 768
1152 × 870

NTSC
NTSC 4:43
PAL
N—PAL
M—PAL
PAL—60
SECAM

60
60
50
50
60
60
50

HDTV (720p)
HDTV (720p)
HDTV (1080i)
HDTV (1080i)
SDTV (480p)
SDTV (576p)
TV480i
TV625i

60
50
60
50
60
50
60
50

Positioning the Projector
If the projector isn’t already installed in the room you’re using,
you’ll probably want to place it on a table in front of the screen.
This lets you stand in the front of the room, face the audience,
and remain close enough to the equipment to be able to control
it. Try to leave as much space as possible between the projector
and the screen to get a good-size image.

3/08

PowerLite 1810p/1815p
Follow these steps to turn on the projector:

Use the figure below to help you determine placement. Image
size increases with distance, but can vary depending on how you
position the zoom ring and whether you’ve adjusted the image
with other settings.

1. Open the A/V mute slide (lens cover).

TBD

29.7 to 48.2 ft

5.7 to 9.4 ft

2.7 to 4.6 ft

Distance from screen

2. Plug one end of the power cable into the projector, and the
other end into an electrical outlet.

Also keep these considerations in mind:
❏ Place the projector on a sturdy, level surface.
❏ Make sure there is plenty of space for ventilation around and
under the projector. Do not set the projector on top of
anything that could block the vents under the projector.
❏ Make sure the projector is within 10 feet of a grounded
electrical outlet or extension cord.
Ideally, you should place the projector directly in front of the
center of the screen, facing it toward the screen squarely. The
base of the lens should be at about the level of the bottom of the
screen.

The Power light turns orange.

Power
light

Screen
Projector

If you place the projector below screen level, you’ll have to tilt it
up by extending the front adjustable foot. This causes the image
to become “keystone” shaped, but you can correct the
distortion.
3. Press the P Power button on the remote control or on top
of the projector.

Turning On and Off the Projector
Turning On the Projector
Turn on any connected computer or video equipment before
starting the projector so it can automatically detect and display
the image source. If you turn on the projector first or have
multiple pieces of connected equipment, you may have to select
the image source manually (see page 5).
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If you want to turn the projector on again, make sure the
orange Power light is not flashing, then press the P Power
button.

The projector beeps once and the Power light flashes green
as the projector warms up, then an image begins to appear.
When the Power light stops flashing and remains green, the
projector is ready for use.

Note: Turn off this product when not in use to prolong the life of
the projector. Lamp life results vary depending on the mode selected,
environmental conditions, and usage.

4. If you are prompted to enter a password, see page 9.
Warning:
Never look into the lens when the lamp is on. This can damage your
eyes and is especially dangerous for children.

Sleep Mode
You can set the projector to automatically turn off the lamp and
enter “sleep mode” when it has not received any signals for up
to 30 minutes. This conserves electricity, cools the projector,
and extends the life of the lamp. You can enable sleep mode in
the Extended menu under Operation. If you are done using the
projector, unplug the power cord. If you want to start
projecting again, press the P Power button.

Using the Direct Power On Function
The Direct Power On function enables faster setup. The
projector starts up automatically when you plug it in or turn it
on with a wall switch. You don’t have to press the P Power
button.
Follow these steps to enable Direct Power On:

Troubleshooting Display Problems

1. Press the Menu button on the remote control or projector
and select the Extended menu.

You Can’t Project an Image

2. Choose Operation and press Enter.

If you don’t see the image you are trying to project, try the
following:

3. Choose Direct Power On and press Enter.

❏ Make sure the cables are connected correctly.
❏ Make sure the Power light is green and not flashing and the
A/V mute slide (lens cover) is open.
❏ If you’ve connected more than one computer and/or video
source, you may need to press the Source Search button on
the projector’s control panel or Search button on the
remote control to select the correct source. (Allow a few
seconds for the projector to sync up after pressing the
button.)

4. Highlight On and press Enter.
5. Press Menu to exit. The setting will take effect the next time
you plug in the projector.
Note: If a power outage occurs when Direct Power On is enabled
and the projector is plugged in, the projector will start when the
power is restored.

❏ If you’re using a PC notebook, see below.
The Projector and Notebook Don’t Display the
Same Image

Shutting Down the Projector

If you’re projecting from a notebook, and you can’t see your
image on the projection screen and on your computer at the
same time, follow these guidelines:

This projector incorporates Instant Off technology. To turn it
off, you can press the P Power button, unplug it, or turn off a
power switch that supplies power to the projector. You don’t
have to wait for the projector to cool off first.

If you’re using a PC notebook:

❏ On most systems, there’s a function key that lets you toggle
between the LCD screen and the projector, or display on
both at the same time. It may be labeled CRT/LCD or have
an icon such as
. You may have to hold down the Fn
key while pressing it. Allow a few seconds for the projector to
sync up after changing the setting.

1. To turn off the projector, press the P Power button on the
remote control or projector. You see a confirmation message.
If you don’t want to turn it off, press any other button.

❏ If the function key doesn’t permit you to display
simultaneously on both screens, you should check your
monitor settings to make sure both the LCD screen and the
external monitor port are enabled.

2. Press the P Power button again. The projection lamp turns
off and you can unplug the power cord.
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Focusing and Zooming the Image

From the Control Panel, open the Display utility. In the
Display Properties dialog box, click the Settings tab, then
click Advanced. The method for adjusting the settings
varies by brand; you may need to click a Monitor tab, then
make sure the external Monitor port is set as your primary
display and/or enabled. See your computer’s documentation
or online help for details.

To sharpen the image, turn the focus ring on the projector. To
reduce or enlarge the image, turn the zoom ring on the
projector.

If you’re using Mac OS X:

You may need to set up your system to display on the projector
screen as well as the LCD screen. Follow these steps:

Focus

1. From the Apple menu, select System Preferences, then
click Displays.

Zoom

®

2. Select VGA Display or Color LCD, click Arrange or
Arrangement, and make sure Mirror Displays is checked.

If the image still isn’t large enough, you may need to move the
projector farther away from the screen. You can also use the
E-Zoom buttons on the remote control to zoom in on a portion
of the image. See page 8 for instructions.

Adjusting the Image

Adjusting the Image Shape
You can maintain a square or rectangular image by placing the
projector directly in front of the screen and keeping it level.
This also produces the best picture quality. If the projector is
tilted up or placed at an angle, you’ll need to correct the image
shape by using one of the functions described below.

Once you see your image, you may need to make certain
adjustments, as described in this section.

Adjusting the Height of the Image
If the image is too low on the screen, you can use the front
adjustable foot to raise it.

Automatic Image Adjustment

Use the projector’s Quick Setup feature to set up quickly for a
presentation. This function automatically corrects the shape
and position of the image to fit on a screen with a 4:3 aspect
ratio. It can correct image distortion when the projector is
placed up to a 45° angle to the screen (vertically) and 20°
(horizontally).

1. Stand behind the projector. Press the foot release lever up
and lift the front of the projector.

1. Press the Quick Setup button on the projector’s control
panel.

2. Once the image is positioned where you want it, release the
lever to lock the foot in position.

You see a projected message:

3. If necessary, you can fine-tune the height or level the image
by turning any of the projector’s adjustable feet.

Raising the projector causes the image to distort or “keystone,”
but you can correct the shape as described in the next section.
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2. Aim the projector so the message appears near the middle of
the screen. Then use the zoom ring to enlarge the image so
the white frame (not shown above) extends beyond the edges
of the screen on all sides.

Using Keystone Correction

The projector automatically corrects vertical keystone distortion
when it is tilted within a range of 30° up or down.

3. Press the Quick Setup button again. Two white boxes flash
momentarily onto the screen, and the adjustment is
complete. Your projected image now fits on the screen (some
slight overlap is normal).

Projector tilted up

The Quick Setup adjustment is retained when the projector is
turned off. If the projector is installed in a fixed location, you
won’t need to repeat the adjustment each time you turn it on.
To fine-tune the Quick Setup adjustment, use Quick Corner .

Corrected image

Projector tilted down

It takes about one second after projection starts for the image to
be corrected. During this time, a vertical keystone correction
gauge appears on the screen. If keystone correction isn’t
automatically performed, you may need to turn on the
Auto V-Keystone setting in the projector’s menu system.

®

Using Quick Corner

Use Quick Corner to adjust the shape and size of the image
when it’s uneven on all sides, or to finely adjust the image after
performing Quick Setup. If you just used Quick Setup, you can
use the projector’s arrow buttons to make the Quick Corner
adjustment. If not, you’ll have to select Quick Corner as
follows:

You can manually adjust the shape of the image to compensate
for vertical and horizontal keystone distortion. First make sure
the Keystone setting in the projector’s menu system is set to
H-Keystone or V-Keystone:
1. Press the Menu button on the remote control (or on the
projector’s control panel).

1. Press the Menu button on the remote control or on the
projector’s control panel.

2. Select the Settings menu and press Enter.

2. Select the Settings menu and press Enter.

3. From the Settings menu, select Keystone and press Enter.

3. From the Settings menu, select Keystone and press Enter.

4. Select H/V-Keystone and press Enter.

4. Select Quick Corner and press Enter.

5. Select H-Keystone (for horizontal adjustment) or
V-Keystone (for vertical adjustment) and use the l and r
arrow buttons to adjust the shape of the image.

You see this screen:

Vertical
keystone
adjustment
Horizontal
keystone
adjustment

If the image becomes smaller, use the zoom ring to enlarge the
image so it fits the screen. If the image contains faint lines or a
gridlike pattern, decrease the sharpness setting.

5. Use the
pointer button on the remote control (or the
arrow buttons on the projector) to select the corner you want
to adjust, and press Enter.

Resizing Video images

6. Use the
pointer button on the remote control (or the
arrow buttons on the projector) to adjust the shape.

You can use the Resize button on the remote control to adjust
how an image fits into the display area. Press Resize to switch
the aspect ratio between 4:3 and 16:9. This lets you play certain
digital video images or movies recorded on certain DVDs in

7. Repeat steps 5 and 6 as needed to adjust any remaining
corners.

When done, press Menu to exit the menu system.

6 - PowerLite 1810p/1815p
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❏ Sports: For vivid TV images projected in a bright room
(video, S-video, or composite video only).

16:9 widescreen format. You can also select 16:9 (Up) or 16:9
(Down) to reposition videos to accommodate subtitles or
supertitles.

❏ Game: Increases brightness when playing video games or
watching TV in a bright room. Emphasizes dark gradations.
❏ sRGB: Matches the color palette of standard sRGB
computer displays.
❏ Blackboard: Projects accurate colors on a green chalkboard
(adjusts the white point).
❏ Customized: For manual color adjustment

Using the Remote Control
When using the remote control, stand within 20 feet of the
projector. Point the remote control either at the projector or at
the screen (the projector’s front sensor can detect signals
bounced off the screen). Press the button for the function you
want to use. Avoid using the remote under bright fluorescent
lamps or in direct sunlight, or the projector may not respond
properly.

For computer images, select Normal to automatically resize the
image and make the best use of the display area.

Adjusting the Brightness
The brightness of an image depends on the source you are
projecting and the amount of light in the room. If the image is
too bright or not bright enough, do one of the following:

Switching Between Picture Sources

❏ Change the Brightness setting in the Image menu.

If your projector is connected to more than one computer
and/or video source, you can switch between the different
sources:

❏ Select Low or High for the Brightness Control option in
the Setting menu. Low Brightness mode extends the life of
the lamp and decreases the fan noise.

❏ The easiest way to select your source is to press the Search
button on the remote control (or the Source Search button
on the projector) repeatedly until you see the image you
want on the screen.

Selecting the Color Mode
The Color Mode adjusts the brightness, contrast, and color for
various common viewing environments. Use this setting to
quickly obtain a good picture.

❏ On the remote control, there are several Source buttons.
Use them to switch between equipment connected to the
port identified on each button, or to use EasyMP (PowerLite
1815p only).

Press the Color Mode button on the remote control, and then
select from one of these options:

After you select a source, the screen goes dark for a moment
before the image appears.

❏ Presentation: For giving color presentations in a bright
room.
❏ Text: For giving black-and-white presentations in a bright
room.
❏ Theatre: For watching movies in a darkened room; gives
images a natural tone.
❏ Photo: For vivid, high-contrast still images in a bright room.
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Turning Off the Picture and Sound

2. Use the

You can temporarily turn off the image and sound when you
want to redirect your audience’s attention. There are two ways
to do this:

3. Continue pressing the E-Zoom
selected area up to 4 times.

pointer button to position the crosshair.
button to enlarge the

4. While the image is enlarged, you can:

❏ Press the A/V Mute button on the remote control. This
turns the image off and stops the sound. To turn the image
and sound back on, press the button again.

❏ Use the

pointer button to move around the screen.

❏ Press the E-Zoom

button to zoom out.

5. When done, press the Esc button to return the image to its
original size.

Controlling the Volume
To change the volume, press the
or
button on the
remote control or projector. You can also adjust the volume
using the projector’s Setting menu.
❏ Close the A/V mute slide, as shown below:

Operating Your Computer with the
Remote Control
If you connect a computer to the projector with a USB cable,
you can use the remote control in place of your computer’s
mouse. This gives you more flexibility when delivering
slideshow-style presentations, since you won’t have to stand
next to the computer to change slides.
❏ Use the
Up and
Down buttons to move through a
Microsoft PowerPoint slideshow.
®

®

Page up or down
to change slides
in PowerPoint

Stopping Action
To stop the action and keep the current image on the screen,
press the Freeze button. The sound continues.

Use to move
pointer on
screen
Left-click

To restart it, press the Freeze button again.

Right-click

❏ Use the
screen.

pointer button to move the pointer on the

❏ Press the Enter button once to left-click, or press it twice to
double-click. Press the Esc button to right-click.
❏ To drag-and-drop, hold down the Enter button. Then use
the
pointer button to drag the object. When it’s where
you want it, release the Enter button.

Zooming Part of Your Image
1. Press the E-Zoom

button on the remote control.

You see a crosshair indicating the center of the zoom-in area.

8 - PowerLite 1810p/1815p
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Starting the Projector with a Password

Using the Projector Security Features

When the password function is enabled, you see this screen
when you plug in and turn on the projector:

To prevent unauthorized use of the projector, you can assign a
password to prevent the projector from being turned on; create
a custom screen that is displayed at startup and/or when the
A/V Mute button is pressed; or disable the projector’s buttons.
You can also attach a security cable to the projector to prevent
theft.

5GG[QWTFQEWOGPVCVKQPHQTOQTGKPHQTOCVKQP

Enabling Password Protection
The default setting for the password is 0000. Follow these steps
to create a new password:
Hold down the Num button on the remote control and use the
numeric keypad to enter the four-digit password. The password
screen closes and projection begins.

1. Press the Freeze button on the remote control for about five
seconds.
You see this screen:

2. Use the
Enter.

If the password is not correct, you see a message prompting you
to re-enter it. If you enter an incorrect password three times in
succession, you see the message The projector’s operation will
be locked and the projector switches to standby mode.
Disconnect the projector’s power cord from the electrical outlet,
reconnect it, and turn the projector back on.

pointer button to select Password and press

3. When you see a message asking if you want to change the
password, select Yes and press Enter.
4. Hold down the Num button on the remote control and use
the numeric keypad to enter a four digit password.

When you see the Password screen again, you can try to enter
the correct password. If you enter an incorrect password 30
times in succession, the projector remains locked and you must
contact Epson to unlock it. If you have forgotten the password,
contact Epson with the request code number that appears in the
Password screen for assistance.

5. When you see a confirmation message, reenter the password.
Then press the Menu button to exit the screen.
To set security options, access the Password Protect screen as
described above, and then turn on any of the following options:
❏ Power On Protect to prevent unauthorized use of the
projector. After the projector is plugged in and turned on,
you must enter a password to use the projector.

Note: If you leave the projector plugged in, the Password Protect
Release screen will not appear. It appears only if you unplug and
reconnect the power cable.

❏ User’s Logo Protect to prevent your custom screen and
display settings from being changed. None of the User’s
Logo features in the Extended menu can be changed when
the User’s Logo Protect function is enabled.

Disabling the Projector’s Buttons
When you enable the Operation Lock function, you can lock all
the projector’s buttons, or all buttons except the P Power
button. The remote control can still be used to operate the
projector.

❏ Network Protect to lock the Network settings in the menu
system (PowerLite 1815p only).
Caution: If you lose the remote control, you will not be able to enter
the password. Keep the remote control in a safe place at all times.
Also, it’s a good idea to write down your password.

1. Press the Menu button, highlight the Setting menu, and
press Enter.
2. Select Operation Lock and press Enter.
3. Select Full Lock (to lock all projector buttons) or Partial
Lock (to lock all buttons except the Power button) and
press Enter.

3/08

PowerLite 1810p/1815p - 9

PowerLite 1810p/1815p
4. Select Yes and press Enter to confirm the setting.

Presenting Through a Wireless
Network (PowerLite 1815p only)

5. Press the Menu button to exit.
To disable the Operation Lock function, select Off in the
Operation Lock menu. Or press and hold the Enter button on
the projector’s control panel for 7 seconds. A message is
displayed and the lock is released.

Using EMP NS Connection, you can project images shown on
your computer screen—including text, graphics, and video—
directly to your audience without connecting the projector to
your computer. Before you begin, make sure you’ve installed
the wireless network module and the EMP NS Connection
software on your computer.

Connecting to a Computer

Starting EasyMP

You can connect the projector to any computer that has a
standard video output (monitor) port, including desktop
models, PC notebook computers, MacBook, PowerBook, and
iBook computers, and hand-held devices.

Before you can connect to the projector wirelessly, you have to
switch it to EasyMP mode. Follow these steps:
1. Point the remote control at the projector and press the
P Power button.

Connecting to the Computer Port

2. Press the EasyMP button on the remote control to select
EasyMP as the source.

You can connect to the projector using the VGA computer
cable that came with it (the monitor port on your computer
must be a mini D-sub 15-pin port).

You see this screen. The network settings appear in the lower
left.

1. If you’re using the VGA computer cable, connect one end to
the projector’s Computer1 or Computer 2 port, and the
other end to your computer’s monitor port.

3. If you’ve already set up your computer and projector for the
mode you want to use—Ad Hoc mode (also called
computer-to-computer mode) or Access Point mode (also
called infrastructure mode)—skip to “Projecting Over a
Network” on page 17.

2. You may need to change the Computer1 Input or
Computer2 Input setting in the projector’s Signal menu to
RGB.
3. You can connect an optional stereo mini-jack audio cable to
play sound through the projector, or connect a USB cable to
use the remote control as a mouse.

Otherwise, continue with the next section.
Note: Use only the Epson 802.11a/b/g wireless module in the
projector. If you see a message asking you to insert a LAN or
memory card, check to make sure your 802.11 a/b/g module is
properly inserted.

Note: The PowerLite 1815p can also be connected to a third PC
(but not to a Macintosh) through a USB connection. See the User’s
Guide for details.

Configuring the Connection

Caution: Don’t try to force a connector to fit a port with a different
shape or number of pins. You may damage the port or connector.

10 - PowerLite 1810p/1815p

You can use NS Connection to connect to the projector and
send images wirelessly in two modes: Ad Hoc mode or Access
Point mode.
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❏ Ad Hoc mode (computer-to-computer mode) lets you
connect just one computer to the projector at a time; it’s easy
to set up, and the only equipment you need is a computer
with a wireless (802.11g, 802.11b, or 802.11a) network card
or adapter, or a Macintosh with an AirPort or AirPort
Extreme card. When you connect to the projector in this
mode, your connection to other wireless networks or devices
is broken; you can connect to the projector only.

You see this screen:

®

❏ Access Point mode (infrastructure mode) lets multiple
computers access the projector at the same time and easily
trade off control of the projector. To use Access Point mode,
you need a wireless (802.11a, 802.11b, or 802.11g) access
point or an AirPort Extreme (or AirPort) base station, and
one or more computers with wireless network cards or
adapters.
Follow the instructions below for the mode you want to use.
Note: To connect to the projector over a wireless network, your
computer must be running Windows 2000 or XP. Your Mac must
be running Mac OS X 10.3 or later.

4. Make sure Quick is selected for the Connection mode. If
not, use the
pointer button on the remote control to
highlight Quick, then press Enter to select it.

Access Point mode (infrastructure mode) is required to achieve
transfer speeds up to 54Mbp/s on an 802.11a/g network. Ad Hoc
mode (computer-to-computer mode) limits network connections to
11Mbp/s. This is a standard specification of 802.11g networking.

5. If your network is using 802.11a, use the
pointer button
on the remote control to highlight 802.11a, then press Enter
to select it.
6. If your computer’s network card supports an SSID or ESSID
name (see page 12), highlight the ESSID text box, press
Enter, and enter a name. Note that the ESSID is casesensitive (if you enter the name in uppercase on the
projector, you must type it the same way on the computer
connecting to the projector).

Using Ad Hoc Mode
To use Ad Hoc (computer-to-computer) mode, adjust your
projector and wireless card or adapter settings as described in
this section.

Use the
pointer button to select individual letters; then
press Enter to input a character. To add a blank space or to
navigate backward and forward through the input text,
highlight the arrows and press Enter. To toggle symbol
settings or capital letters, highlight the option and press
Enter. When you’re done, highlight Finish and press Enter.

Configuring the Projector

1. Press the Menu button, then choose Network and press
Enter.
2. Choose Network Configuration and press Enter.
3. Choose Wireless LAN and press Enter.

7. When you’re done making these settings, select Return,
select Setup complete, and then select Yes to confirm that
you want to save the changes. Press Menu to exit the menu
system.
Now you’re ready to set up your computer to project wirelessly.
Go to “Configuring the Network Settings for Windows” in the
next section, or “Configuring the Network Settings for
Macintosh” on page 12.
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4. Click the Advanced tab. You see a screen similar to this:

Configuring the Network Settings for Windows

Before connecting to the projector, you need to make sure the
settings for your notebook’s or PC’s network card match the
settings you entered for the projector.
1. Access your wireless network Properties window. For
example, in Windows XP you would click Start > Control
Panel > Network and Internet Connections. Then click
the Network Connections icon. You see a screen similar to
this:

Right-click and select Properties

5. Check your wireless card or adapter device settings.
(Depending on the type of card or adapter you’re using,
some of the settings may be different from those listed here.)
❏ Set the Network Type to 802.11 Ad Hoc.
❏ Set the SSID to match the name you assigned to the
projector’s ESSID.

2. Right-click the Wireless Network Connection icon and
select Properties. You see a screen similar to this:

❏ Make sure Encryption is Disabled.
6. Click the General tab and make sure that your wireless card
or adapter is enabled.
7. When you’re done, click OK to close the Properties dialog
box.

Click here

Now you’re ready to connect to the projector. See “Projecting
Over a Network” on page 17.
Note: When you connect in Ad Hoc mode, your connection to other
wireless networks or devices is broken. If you need to remain
connected to your wireless network, use Access Point mode. Also,
make sure you reconnect to your original wireless network when you
are done using the projector.
Configuring the Network Settings for Macintosh

Your AirPort software is automatically configured to allow your
Mac to detect both computer-to-computer (Ad Hoc) and
Access Point networks. Typically, you only need to select your
projector’s ESSID from the AirPort status menu on the Mac
menu bar. If you’re having problems detecting the projector,
follow these steps:

3. Click the Configure button.

1. From the Apple pull-down menu, select System
Preferences.
2. Double-click the Network icon. You see the Network
settings window.

12 - PowerLite 1810p/1815p
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3. Choose Wireless LAN and press Enter. You see this screen:

3. Make sure Location is set to Automatic.
Select
Automatic
Select
Network Port
Configurations

then select
AirPort

4. Make sure Advanced is selected for the Connection mode.
If not, use the
pointer button on the remote control to
highlight Advanced, then press Enter to select it.

4. Select Network Port Configurations in the Show pulldown menu.
5. Under Port Configurations, select AirPort.

5. If your network is using 802.11a, use the
pointer button
on the remote control to highlight 802.11a, then press Enter
to select it.

6. Click Apply Now. Then close the window.
7. Click the AirPort icon on the menu bar at the top of the Mac
desktop. You see the AirPort status menu:

6. To enable your computer to find the projector on the
network, you need to enter the SSID name of your access
point or AirPort network in the ESSID text box. (The name
of your AirPort network may be different from that of your
AirPort base station; select your base station in the AirPort
Admin utility and click Configure to check the name of
your network.)

Choose the ESSID
you assigned to the
projector

Highlight the ESSID text box, press Enter, and enter a
name. Note that the ESSID is case-sensitive (if you enter the
name in uppercase on the projector, you must type it the
same way on the computer connecting to the projector).

8. Check to make sure AirPort is turned on.
9. Select your projector’s ESSID.

Use the
pointer button to select individual letters; then
press Enter to input a character. To add a blank space or to
navigate backward and forward through the input text,
highlight the arrows and press Enter. To toggle symbol
settings or capital letters, highlight the option and press
Enter. When you’re done, highlight Finish and press Enter.

Note: If you don’t need the other network port configurations,
disable them by deselecting their checkboxes.
Now you’re ready to connect to the projector. See “Projecting
Over a Network” on page 17.

Using Access Point Mode
To use Access Point (infrastructure) mode, first adjust your
projector and wireless access point or AirPort base station
settings as described in this section.
Configuring the Projector

1. Press the Menu button, then choose Network and press
Enter.
2. Choose Network Configuration and press Enter.

7. If your access point assigns IP addresses automatically, turn
on DHCP. Otherwise, turn off DHCP and enter the
following information:
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❏ IP address: Enter the IP address you want to assign to
the projector. It must be formatted like other addresses
on the network. The last octet should be unique.

2. Right-click the Wireless Network Connection icon and
select Properties. You see a screen similar to this:

❏ Subnet mask: For example: 255.255.255.000, but this
depends on how your network is set up.
❏ Gateway address: Enter the IP address that was
assigned to the access point or AirPort base station when
it was set up.

Click here

8. When you’re done making these settings, select Return,
Setup complete, and then Yes to confirm that you want to
save the changes. Press Menu to exit the menu system.
Now you’re ready to set up your computer for wireless
projecting. Go to “Configuring the Network Settings for
Windows” in the next section, or go to “Configuring the
Network Settings for Macintosh” on page 16.
Note: For specific details about your network, please consult your
network administrator. If you don’t know your gateway or access
point address, see page 16. If you’re using AirPort, start the AirPort
Admin utility, select your base station and click Configure. Then
click the Network tab to see your base station’s IP address.

3. Click the Configure button.
4. Click the Advanced tab. You see a screen like this:

Configuring the Network Settings for Windows

Before connecting to the projector, you need to make sure the
settings for your computer’s wireless card or adapter match the
settings you entered for the projector.
1. Access your wireless network Properties window. For
example, in Windows XP you would click Start > Control
Panel > Network and Internet Connections. Then click
the Network Connections icon. You see a screen similar to
this:

5. Check your wireless card’s or adapter’s device settings.
(Depending on the type of card or adapter you’re using,
some of the settings may be different than those listed here.)

Right-click and select Properties

❏ Set the Network Type to Infrastructure.
❏ Set the SSID to match the name assigned to the access
point (which should also match the projector’s ESSID).
❏ Make sure Encryption is Disabled if you have not set up
encryption on the projector.
6. Click the General tab and make sure that your wireless card
or adapter is enabled.
7. When you’re done, click OK to close the wireless properties
dialog box.
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❏ Preferred DNS server/Alternate DNS server: Enter
the IP address of the DNS server(s) for your network.

8. Right-click the Wireless Network Connection icon again
and select Properties. You see this screen:

11.When you’re done, click OK.
12.Click the Wireless Networks tab. (If you don’t see this tab,
you may need to enable your wireless card or adapter by
clicking Configure to access the device settings; then follow
any instructions on the screen to enable the device.)
You see a screen like this:

9. Select Internet Protocol and click the Properties button.
You see this screen:

13.Verify that you’ve enabled your computer’s connection to
the access point. It should be listed with the small icon
next to it, indicating a connection. If it’s not listed, click
Configure and type the name of your access point.
14.When you’re done making settings, click OK to close the
dialog box.
Now you’re ready to connect to the projector. See “Projecting
Over a Network” on page 17.
Note: On some Windows systems, you can right-click My Network
Places or Network Neighborhood on the desktop and select
Properties. Settings may vary, depending on your wireless network
adapter. See the documentation for your adapter for more
information.

10.If your access point uses DHCP, select Obtain an IP
address automatically. Otherwise select Use the
following IP address and Use the following DNS server
addresses, then enter the required information:
❏ IP address: Type in the IP address you want to assign to
the computer. It must be formatted like other addresses
on the network. The last octet should be unique.
❏ Subnet mask: For example: 255.255.255.000, but this
depends on how your network is set up.
❏ Default gateway: Enter the IP address that was assigned
to the access point when it was set up.
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Checking the Gateway IP Address on Windows

Configuring the Network Settings for Macintosh

If you’re entering IP addresses manually and need to find out
the gateway IP address (the IP address of your access point),
make sure the wireless connection to the access point is
currently active, as described in the previous section. Then
follow these steps:

Your AirPort software is automatically configured to allow your
Mac to detect Access Point networks. Typically, you only need
to select your AirPort network name from the AirPort status
menu on the Mac menu bar. If you’re having problems
connecting to the projector, follow these steps:

1. Access your wireless network Properties window. For
example, in Windows XP click Start > Control Panel >
Network and Internet Connections. Then click the
Network Connections icon. You see a screen similar to this:

1. From the Apple pull-down menu, select System
Preferences.
2. Click the Network icon. You see the Network settings
window.
3. Make sure Location is set to Automatic.

Select
Automatic
Select
Network Port
Configurations

Then select
AirPort

2. Right-click the Wireless Network Connection icon and
select Status.
3. Click the Support tab. The gateway’s IP address is listed as
shown:

4. Select Network Port Configurations in the Show
pull-down menu.
5. Under Port Configurations, select AirPort.
6. Click Apply Now. Then close the window.

Gateway address

7. Start the AirPort Admin utility. Select your base station,
then click Configure.
8. On the AirPort tab, make sure your AirPort network name
matches your projector’s ESSID. If not, enter the projector’s
ESSID in the AirPort Network text box and click Update.
9. If you turned DHCP on in your projector’s advanced menu,
click the Network tab and make sure the Distribute IP
addresses checkbox is selected. If you need to select it, click
Update.

Note: If you cannot identify the gateway address using this
Windows utility, use the administrator’s utility software that came
with your access point.
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10.Click the AirPort icon on the menu bar at the top of the
Macintosh desktop. You see the AirPort status menu:

3. The first time you start NS Connection, you see this dialog
box. Choose Quick Connection Mode and click OK.

11.Check to make sure AirPort is turned on.
12.Select the name of your AirPort network.
4. If you see a message asking you to disable the firewall make
an exception for the projector and allow projection. You see
the screen below. (If you have previously started NS
Connection, this may be the first screen you see.)

Note: If you don’t need the other network ports, disable them by
deselecting their checkboxes. If more than one network port is
enabled, the projector software warns you to turn off AirPort when
you first connect the projector. Disregard this message.
Your AirPort network and base station names may be different. To
check or change your AirPort network name, start the AirPort
Admin utility, select your base station, and click Configure. Click
Show All Settings, then make any changes you want on the AirPort
tab.
If you’re connecting to your projector in static IP mode, deselect the
Distribute IP addresses checkbox. Make sure your projector’s
gateway address is identical to the base station’s IP address, and the
first three segments of the projector’s IP address are identical to the
first three segments of the base station’s IP address.

Projecting Over a Network
Once you’ve started EasyMP and set up your projector and
computer in either Ad Hoc (Quick) mode or Access Point
(Advanced) mode, follow these steps to start NS Connection
and project over the network.

Select projector

If the connection is working properly, you see your projector
listed. If you don’t see your projector listed, see “Solving
Connection Problems” on page 18. If you have additional
Epson projectors on the network, they are also listed along
with their status.

1. Make sure you’ve set up your projector.
2. Windows: Select EMP NS Connection from the Start
menu.
Mac OS X: Double-click the EMP NS Connection icon in
your Applications folder.

5. Once the name of your projector appears, select it and click
Connect. If more than one projector is listed, you can select
additional ones and connect to them (up to four) at the same
time.
If the selected projector is already being used by another
person, you can still connect to it (unless it is “locked”);
doing so automatically disconnects the other user. If a
projector is locked, you won’t be able to connect to it when
it is in use.
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6. If you set up the projector to prompt you for a keyword
before connecting, you see a screen like this one:

Disconnects the connection to the projector.
Changes which buttons are displayed on the control
bar.

Clicking one of the buttons on the control bar may cause a
submenu to appear above the control bar.
When you’re done, click the arrow in the upper right corner to
close the submenu.

Enter keyword

Solving Connection Problems
If you don’t see your projector on the EMP NS Connection
screen, then check the following:

Type in the four-digit number displayed on the EasyMP
Network screen and click OK.

❏ Make sure your wireless signal is strong enough to establish a
connection. If you have a Mac, check the AirPort icon on the
Mac menu bar. For Windows, see the documentation for
your access point or wireless network card or adapter.

7. Once the connection is established, you see your computer’s
image transmitted to the screen and a floating control bar on
your computer desktop:

❏ Make sure you’re trying to connect to the right network. In
Windows, verify that you’ve enabled your computer’s
connection to the access point or that your wireless card or
adapter is enabled, and that its SSID matches the projector’s
ESSID. In Mac OS X, check the AirPort status menu (click
the AirPort icon on your menu bar) to make sure AirPort is
turned on and the projector’s ESSID or your AirPort
network is selected.

Windows

Macintosh

8. If necessary, you can drag the control bar out of the way on
your screen.

❏ Make sure you aren’t projecting one of the EasyMP
configuration screens. (You should see a message that the
projector is ready to connect.) If you have to exit a
configuration screen, restart NS Connection.

9. When you’re done with your presentation, click Disconnect
on the control bar.
Using the Control Bar

❏ Make sure the ESSID for your projector matches the SSID
for your wireless card, adapter, or access point. If you have
an AirPort base station, make sure the projector’s ESSID
matches the AirPort network name. Remember that the
ESSID is case-sensitive.

From the control bar, you can access these NS Connection
features:
Displays the Select target projector dialog box.
Stops projection of computer images while connecting
to the projector.

❏ Check the IP address for both your projector and your
wireless card, adapter, access point, or AirPort base station.
The first three octets of the IP address should be identical.
The last octet of the projector’s IP address should be close,
but not identical, to the last octet of the IP address for your
wireless interface, access point, or base station.

The projector projects the computer image.
Pauses projection of computer images. Click again to
restart projection.
Starts Presentation Mode for the selected projector.
In Presentation Mode, only your slideshow images are
projected.
Displays the Projector Control screen, which allows you
to enable A/V Mute, switch the PC source, or switch
the video source.
Starts Movie Sending Mode for projecting MPEG2
videos from your computer (Movie Sending Mode does
not work with DVD movies).
Allows you to set up Multi-screen display and see a
preview of how the images will appear on each screen.

❏ Restart your computer and start NS Connection again.
❏ If you still don’t see your projector, follow the instructions in
“Connecting in Advanced Connection Mode” in the next
section to connect to the printer.

Displays the Projector Settings dialog box.
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Once you’ve selected the IP address for your network adapter,
you won’t see the Switch network dialog box when you start NS
Connection. If you want to change to a different network
adapter, click Extension on the EMP NS Connection dialog
box, then click Switch LAN on the extension dialog box.

Connecting in Advanced Connection Mode

1. Click Manual search on the NS Connection screen.

If a projector is in use and is “locked,” you won’t be able to
select it. To lock the projector from connection by other users
while you are connected, click the Disable interrupt
connection checkbox. De-select it to disable the lock and allow
connection by other users.
Note: If you’re using AirPort, the network name may be different
than the AirPort base station name. To check the network name,
start the AirPort Admin utility, select your base station, and click
Configure. Then click Show All Settings. The network name
appears on the AirPort tab.

Managing Projectors (PowerLite
1815p only)

2. Enter the IP address or the projector name for the projector
you want to connect to, and click OK.

The software included with your projector lets you monitor and
control your projectors from a remote computer.
❏ Use EMP Monitor (available for Windows only) to see your
projectors’ status, switch image sources, and control basic
settings.
❏ Use the mail notification function to receive e-mail alerts
about possible problems.
You can also use NS Connection to register up to 16 projectors
as a group. This allows you to provide quick and easy access to
these projectors from other computers.

The Projector is added to the EMP NS Connection screen.
If the search fails to find a projector with the specified IP
address, the searching icon turns into a question mark. If this
happens, run EasyMP on your projector (see page 10) to
check the projector’s IP address, then repeat this step.

To use the software to manage your projectors, you must first
install EMP Monitor. If you plan to create projector groups,
also install EMP NS Connection. Then connect and configure
each projector you want to monitor. You can connect the
projector wirelessly in Access Point mode (see page 13) or over a
wired network as described here.

3. Click the projector you want to connect to and click the
Connect button. If more than one projector is listed, you
can select additional projectors and connect to them at the
same time.
4. If you are prompted for a keyword, enter the four-digit
number displayed on the EasyMP Network screen and click
OK.

Using EMP Monitor
EMP Monitor lets you use a remote computer to manage your
projectors, whether connected wirelessly or over a wired
network. It lets you easily turn the projectors on or off (together
or individually), switch image sources, and check their status.

The computer’s image is transmitted to the projector and
appears on the screen. See page 18 for details about using the
floating control bar on your computer desktop.

Before using EMP Monitor, make sure you’ve installed the
software (available for Windows only). The computer you’re
using to monitor the projector should already be connected to
your network.

Solving Other Connection Problems

If you don’t see your network adapter’s IP address, allow a
minute for it to appear. If your access point or AirPort base
station uses DHCP (Distribute IP addresses setting is enabled
for AirPort), sometimes it takes a minute for the server to pick
up the IP address.

Opening and Closing EMP Monitor

To start EMP Monitor, click Start > Programs or All
Programs > EPSON Projector > EMP Monitor.
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2. Select Edit > New > Projector (automatic search). You see
this screen:

If you’ve added the program to the Startup programs folder,
then it may already be open. If so, click the icon in the system
tray on the lower-right corner of your screen to display the EMP
Monitor window:

Click here to start EMP Monitor

To close EMP Monitor, select Exit from the File menu or rightclick the program icon shown above, then select Exit.
Note: If you want to monitor projectors while they are in standby
mode, select Standby Mode in the Extended menu, then select
Network On.

Registering a Projector
Before you can monitor a projector, you have to register it.
Follow these steps to automatically search for your projector(s).

3. Click Search to locate projectors currently operating on the
network. Any projectors found on the network are listed as
shown below:

1. Open EMP Monitor as described above. You see this screen:
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Note: If the projector is not automatically found, it may not be
connected or configured correctly for the network. To delete a
projector from the list, right-click the projector name, and click
Delete.

4. Select the projector you want to add by clicking its name,
then click the Edit button. You see this screen:

Monitoring Your Projectors
The EMP Monitor screen lets you monitor your projectors
using the Status, Video Source, and Error icons shown below.
This lets you see which projectors are currently being used,
from which source (or port) they are projecting an image, and if
a problem occurs.
For detailed status information, right-click the projector in
question and click Property. The following tables describe the
status icons shown on the EMP Monitor screen.

Group status icons
No warnings or problems. All projectors in
the group are operating normally.
Warning or problem. A projector in the
group has a warning or problem.
Monitoring disabled. Right click the icon
and select Monitoring Enabled to begin
monitoring the group.

5. Enter a Display name and select a Display icon. Select a
Parent group (if necessary) then enter a Monitor Password (if
necessary) and a Description for the projector. Click the
Register button. To register additional projectors with EMP
Monitor, repeat steps 2 through 5.

Data is currently being updated.

Type status icons
No warnings or problems.

6. When you’re done adding projectors, click Cancel. You see
a screen with a list of all registered projectors:

Warning or problem.
Monitor Password error. No monitor
password was entered when the projector
was registered, or an incorrect password
was entered.
Monitoring disabled. Right-click the icon
and select Monitoring Enabled to begin
monitoring the projector.
Data is currently being updated.
Network error (for example, the projector is
not connected to the network, or the
power cable is disconnected).
You may also see this error if Network Off
is selected in Standby Mode.
Network error (Esc/VP.net communication
error).
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Error status icons (continued)
Power status icons

Lamp failure at power on. The lamp has
reached its end of life or is installed
incorrectly.

The projector is powered on and its status
is normal.

High internal temperature error. The
projector is turned off automatically.

The projector is powered off and its status
is normal.

Internal (system) error. Contact Epson for
help.

The projector is powered on and its status
is abnormal.

Fan error. Contact Epson for help.

The projector is powered off and its status
is abnormal.

Sensor error. Contact Epson for help.

Temperature level status icons

Other error. Contact Epson for help.

The projector’s internal temperature is
normal (low).

Note: To monitor a projector when it’s in standby mode (plugged in
but not turned on), you must select Network On as the Standby
Mode setting in the projector’s Extended menu.

The projector’s internal temperature is
normal (medium).

Controlling Your Projectors

The projector’s internal temperature is
normal (high).

The control buttons in the upper-right let you turn the
projector on and off and select video sources. (Hold the mouse
pointer over a button to see a description of its meaning.) Make
sure you’ve selected the projector you want to operate (with the
mouse pointer) before clicking one of the buttons.

The projector’s internal temperature is high
(high-temperature warning).
The projector’s internal temperature is too
high (internal temperature error). The
projector is turned off automatically.

Error status icons
Control buttons

Lamp life warning. The lamp is nearing the
end of its life.
High-temperature warning. The projector is
getting too hot but continues to operate.
Replace air filter.

No air filter. The air filter is not installed or
installed incorrectly.
Low air flow. The air filter needs to be
cleaned or replaced.
Air flow sensor error. There is a problem
with the projector’s air flow sensor; contact
Epson for help.

Configuring the Monitoring Interval

If you need to have the most current status information about
your projectors, click the Refresh button in EMP Monitor.

Lamp cover door open. Close the lamp
cover door.
Lamp out. The lamp has reached the end of
its life.
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What To Do When the Lights Flash

To select how often EMP Monitor checks the status of
projectors, follow the steps below:

The lights on top of the projector indicate the projector’s status.

1. From the Tool menu, select Environment Setup. You see
this screen:

Power light

Temperature light

Lamp light

The following table describes the projector’s status lights.

Status lights

2. Enter the desired Update interval and click OK.

Light

Note: If you want EMP Monitor to run whenever you start your
computer, click Register at startup.

Status

Description

Orange

The projector is in sleep or standby
mode. You can unplug it or press the
P Power button to turn it on.

Flashing
green

The projector is warming up. Wait for the
image to appear.

Green

The projector is operating normally.

Flashing
orange

The projector is cooling down. You can’t
turn it back on until the light stops
flashing and remains orange.

Red

There is a problem with the projector.
Check the other two lights and the
information on this page to diagnose the
problem.

Flashing
orange

Rapid cooling is in progress. Although
this is not an abnormal condition,
projection will stop automatically if the
temperature rises higher. Make sure
there is plenty of space around and under
the projector for ventilation, and that the
air filter and vents are clear.

Understanding the Notification Messages

If a projector experiences a problem, EMP Monitor sends an email message to each of the addresses you entered in the Set
mail notification function window. The subject line of the
message includes the projector’s display name, shown in EMP
Monitor, and the warning/error. The body of the message
contains the projector’s display name in EMP Monitor and the
error/warning message. When the problem has been fixed, EMP
Monitor sends a message indicating the problem has been
resolved.
Note: If a projector develops a critical problem, it may not be
possible for it to report the error.

Checking Projector Status
If your projector isn’t working correctly, first turn it off, wait for
it to cool (the Power light stops flashing orange), and unplug it.
Then plug the power cord back in and turn on the projector. If
this doesn’t solve the problem, check the lights on top of the
projector.
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Status lights (continued)
Light

Status

Description

Red

The projector is overheating, which turns
the lamp off automatically. Wait until the
cooling fan stops, then unplug the power
cord. Plug the cord back in and press the
P Power button. Make sure the room
temperature is not above 95 °F (35 °C),
and there is plenty of space around and
under the projector for ventilation.
If you’re using the projector above an
altitude of 5,000 feet (1,500 m),
turn on High Altitude Mode in the
Operation menu.
The air filter or vents may be clogged.
Clean them or replace the air filter. If the
projector continues to overheat after you
clean the air filter, the problem may be
caused by damage to the cooling fan or
temperature sensor. Contact Epson for
help.

Flashing
red

There is a problem with the fan or
temperature sensor. The air filter or
vents may be clogged. Clean them or
replace the air filter. If this does not
resolve the problem, stop using the
projector, disconnect the power cable,
and contact Epson for help.

Flashing
orange

It’s time to replace the lamp. See
page 25 for instructions. If you continue
to use the lamp after the replacement
warning, there is an increased possibility
that the lamp may break.

Flashing
red

The lamp may be burnt out. First make
sure the lamp cover is securely installed.
If that’s not the problem, let the lamp
cool, remove the lamp, and replace it as
described on page 25. The air filter or
vents may be clogged. Clean them or
replace the air filter. If this does not
resolve the problem, contact Epson.

Flashing
red

Power is cut off because of an internal
problem. Unplug the power cord and
contact Epson for help.

Warning: Before you clean any part of the projector, turn it off and
unplug the cord. Never open any cover on the projector, except the
lamp cover. Dangerous electrical voltages in the projector can injure
you severely. Do not try to service this product yourself, except as
specifically explained in this manual or the User’s Guide. Refer all
other servicing to qualified service personnel.

Cleaning the Projector Case
Before you clean the case, turn off the projector and unplug the
power cord.
❏ To remove dirt or dust, wipe the case with a soft, dry,
lint-free cloth.
❏ To remove stubborn dirt or stains, wipe the case with a soft
cloth moistened with a mild detergent.
Caution: Do not use wax, alcohol, benzene, paint thinner, or other
chemical detergents. These can damage the case.

Cleaning the Air Filter and Vent
Your projector includes an air filter to ensure the best
performance. If dust collects on the air filter (on the bottom of
the projector) or vent (on the front of the projector), clean them
as described below. Dust clogs prevent proper ventilation and
can cause overheating and damage the projector. Follow these
steps:
1. Turn off the projector and unplug the power cord.
2. To clean the intake vent and filter, use a small vacuum
cleaner designed for computers and other office equipment.
If you don’t have one, gently clean the vent with a soft brush
(such as an artist’s paintbrush).
You can remove the air filter to clean both sides.

Vent

Maintaining the Projector
Air filter

Cleaning the Lens
Clean the lens whenever you notice dirt or dust on the surface.

3. If the dirt is difficult to remove or the filter is broken, replace
the filter.

❏ Use a canister of compressed air to remove dust.
❏ To remove dirt or smears on the lens, use lens-cleaning
paper. If necessary, moisten a soft cloth with lens cleaner and
gently wipe the lens.
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Replacing the Lamp and Air Filter

4. Loosen the two screws holding the lamp in place (you can’t
remove them).

The life span of the projection lamp is about 2,500 hours if
Brightness Control in the Settings menu is set to High
(default), and 3,000 hours if Brightness Control is set to Low.
It is time to replace the lamp when:

Loosen, but don’t
remove these screws

❏ The projected image gets darker or starts to deteriorate.
❏ The message Replace the lamp appears on the screen when
the lamp comes on and the lamp warning light
flashes
orange. To maintain projector brightness and image quality,
replace the lamp as soon as possible.
❏ The lamp warning light
out).

flashes red (the lamp is burnt

5. Hold the lamp as shown and pull it straight out.
Lamp
warning
light

Follow these steps to replace the lamp and air filter:
1. Turn off the projector and unplug the power cord.

6. Gently insert the new lamp. (If it doesn’t fit easily, make sure
it is facing the right way.)

2. Let the projector cool for at least an hour (if it has been on).
The lamp is extremely hot immediately after use.

7. Once the lamp is fully inserted, tighten its screws.

3. Loosen the lamp cover screw (you don’t need to remove it).
Then slide the lamp cover to the side and lift it off the
projector.

8. Replace the lamp cover, then tighten its screw.
9. Slide out the air filter on the bottom of the projector and
remove it.

10.Slide in the new air filter until it clicks in place.
11.Reset the lamp timer as described in the next section.
Note: When you get a replacement lamp for your projector, you
should replace the filter. Turn off this product when not in use to
prolong the life of the projector.
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The lamp(s) in this product contain mercury. Please consult
your state and local regulations regarding disposal or recycling. Do
not put in the trash.
Warning: Let the lamp cool fully before replacing it. In the unlikely
event that the lamp has broken, small glass fragments may be
present and should be removed carefully to avoid injury. If the lamp
is used after the replacement period has passed, the possibility that
the lamp may break increases. When a lamp replacement message
appears, replace the lamp with a new one as soon as possible, even if
it is still working.
Resetting the Lamp Timer

After you replace the lamp, you need to reset the lamp timer
using the projector’s menus.

Product

Part number

Kensington® security lock

ELPSL01

50-inch portable screen
60-inch portable pop-up screen
80-inch portable pop-up screen
83.6-inch hanging pull-down screen
DUET portable projector screen (4:3/16:9
combination)

ELPSC06
ELPSC07
ELPSC08
ELPSC09
ELPSC80

Component video cable (VGA-to-RCA)
S-Video cable

ELPKC19
ELPSV01

Distribution amplifier

ELPDA01

Image presentation camera (ELPDC05)

V12H162020

You can purchase these accessories from an Epson authorized
reseller. To find the nearest reseller, call 800-GO-EPSON
(800-463-7766). To purchase online, visit
www.epsonstore.com (U.S. sales) or www.epson.ca
(Canadian sales).

1. Press the Menu button on the remote control or on the
projector’s control panel. You see the main menu.
2. Use the
pointer button on the remote control (or the
arrow buttons on the projector) to highlight Reset, then
press Enter. You see this screen:

Related Documentation

3. Select Reset Lamp Hours and press Enter.
4. When you see the prompt, select Yes and press Enter.
5. When you’re finished, press Menu to exit the menu system.

CPD-23262

PowerLite 1810p Quick Setup (English)

CPD-23263

PowerLite 1810p Installation rapide
(French)

CPD-23264

PowerLite 1810p Guide de
installación (Spanish)

CPD-23265

PowerLite 1810p Guia de
instalação (Portuguese)

CPD-23254

PowerLite 1815p Quick Setup (English)

CPD-23255

PowerLite 1815p Installation rapide
(French)

CPD-23256

PowerLite 1815p Guide de
installación (Spanish)

CPD-23257

PowerLite 1815p Guia de
instalação (Portuguese)

CPD-23266R2

CD-ROM containing the
PowerLite 1810p and 1815p User’s Guide
in English, French, Spanish, and
Portuguese

Optional Accessories

Product

Part number

Replacement lamp

V13H010L40

Air filter replacement set (2 filters)

V13H134A08

Universal ceiling mount
False ceiling plate
Security bracket/cabling for gyro lock mounts
Adjustable ceiling channel
Suspension adapter

ELPMBUNI
ELPMBFCP
ELPMBSEC
ELPMBACC
ELPMBAPL
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